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The FLIP Guidelines 
 

Background 

 

It has been a while that the Building Information Modeling (BIM) is used in the industry. BIM models are 

shared within project teams during the design and construction process. As-built BIM models are often 

required by building owners so that information about the building can be retrieved by the operators. To 

ensure the consistency flow of information, a well-organized set of information is needed so that 

everyone in the project team can understand and use the information in the BIM model efficiently. Most 

of the information (such as building components data, schedules and quantity) in the BIM model is 

generated from Families, therefore it is important to identify what information is needed in a Family and 

in which stage of the project. 

 

Localized Data 

 

The default Revit templates and Family library may not wholly tally with the local standards and 

practices. Our aim is to organize localized contents to reduce individual effort in the industry to repeat 

the localization process so as to adopt BIM in a more efficient way. 

 

FLIP 

 

Family Library Interchange Program (FLIP) is the collaboration between Autodesk Far East Ltd and 

local BIM Consultant Advanced Consultation Information Development Ltd (A.C.I.D.) and Synnex 

Technology International (HK) Ltd.   

 

It is a well-organized web-based platform that standardized and localized Families are stored and 

categorized according to strict guidelines. Naming convention, styles, level of details and parametric 

properties are systematically organized according to local practices. 

 

It is an interactive platform that facilitates and encourages Revit users to share and exchange organized 

families to enhance productivity as a whole.  Users can download the guideline on how to build 

Families, assign Parameters and Level of Development (LOD). 

 

This document is a guideline for users using and creating Family for the Family Library Interchange 

Program (F.L.I.P.). Most of the contents are reference from the “Revit Model Content Style Guide 

(Ver.2.1)” with modification for the use in local market. 
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The latest version of “Revit Model Content Style Guide” can be downloaded from: 

http://revit.autodesk.com/Library/RMCSG/Revit_Model_Content_Style_Guide_v2_1.zip 

 

For further information about creating Family, please refer to the link below: 

http://knowledge.autodesk.com/support/revit-products/learn-

explore/caas/CloudHelp/cloudhelp/2014/ENU/Revit/files/GUID-81A12807-A549-4722-BD14-

FEE16DAA747E-htm.html 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Developed by 

 

 

 

Supported by:  

 

 

  

http://revit.autodesk.com/Library/RMCSG/Revit_Model_Content_Style_Guide_v2_1.zip
http://knowledge.autodesk.com/support/revit-products/learn-explore/caas/CloudHelp/cloudhelp/2014/ENU/Revit/files/GUID-81A12807-A549-4722-BD14-FEE16DAA747E-htm.html
http://knowledge.autodesk.com/support/revit-products/learn-explore/caas/CloudHelp/cloudhelp/2014/ENU/Revit/files/GUID-81A12807-A549-4722-BD14-FEE16DAA747E-htm.html
http://knowledge.autodesk.com/support/revit-products/learn-explore/caas/CloudHelp/cloudhelp/2014/ENU/Revit/files/GUID-81A12807-A549-4722-BD14-FEE16DAA747E-htm.html


 

4 

Table of Contents 
 

 

1 Recommended Family File Sizes............................................................... 5 

2 Level of Detail ............................................................................................. 6 

3 Element Visibility ........................................................................................ 7 

4 Consideration for Nesting Family Content ............................................... 8 

5 Planning a Revit Model Family .................................................................. 9 

6 Workflow for Model Content Creation ..................................................... 10 

7 Family Units ............................................................................................... 11 

8 Family Naming Conventions .................................................................... 12 

9 Type Naming Conventions ....................................................................... 14 

10 Category and Sub-category Standards and Usage ................................ 16 

11 Approved Parameter Usage ..................................................................... 17 

12 Adding Manufacturer Data to Families ................................................... 18 

13 Parameter Naming Conventions .............................................................. 19 

14 Material Naming Conventions ................................................................. 21 

15 Preview Image Standards ........................................................................ 23 

16 Type Catalog Standards and Usage ........................................................ 27 

17 Best Practices for Adding Connectors in Revit MEP Families .............. 28 

18 Exchange the Family files in FLIP ........................................................... 33 

 
  



 

5 

1 Recommended Family File Sizes 
 

Efficient geometry creation, judicious use of parametric constraints, and carefully planned detail and 

visibility settings can reduce the performance impact a Family will have on the projects in which it is 

used. 

 

For example, a window Family that is intended to be used hundreds of times in a large commercial 

project will have a smaller file size if it contains only basic schematic and design development 

representations.  Impact on the project size will be as minimal as possible. 

 

Conversely, a different window Family intended for use in a small residential project may contain a high 

quality rendering representation that will increase project file size when the Family is added, but 

because the windows it creates are added to the project only a few times, the increase in file size is 

manageable. 

 

To provide content creators with a tangible guideline for Family file size, some common Family types 

and their recommended file sizes are listed below. 

 

Architecture Family:  

Simple Level:  200 – 300 KB 

Complex Level:  500 – 600 KB 

 

MEP Family:  

Simple Level:  200 – 400 KB 

Complex Level:  800 – 1000 KB 

 

Structure Family:  

Simple Level:  180 – 200 KB 

Complex Level:  300 KB 

 

IMPORTANT:  To help reduce the file size, in Revit, click File→Purge Unused to delete items that 

are not in use, click File menu→Save As, and verify that the Compact File option is selected when 

saving the file. 

 

 

 

Back to Contents Page  



 

6 

2 Level of Detail 
 

Detail levels determine which pieces of Family geometry display in different types of project views. 

When a Revit element is created with a Family and added to a project view, the current detail level of the 

view (coarse, medium, or fine) displays the appropriate Family geometry. 

 

A Window displayed in both Coarse and Fine detail 

 

 

When deciding what level of detail should be shown, use the following: 

 

 Don’t model geometry that will not be visible when the Family is added to a building model. For 

example, for a table Family that includes a drawer, model the face only, not the entire drawer. 

 

 Depending on the type of Family, use the following guideline when modeling geometry: 

 

If the geometry is … Set the detail level to … 

Smaller than 300mm Fine 

300 to 1m Medium 

Larger than 1m Coarse 

 

 Do not duplicate geometry that can be used for different levels of detail. 

 

IMPORTANT: The intent is not to build each level of detail incrementally or additionally. 
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3 Element Visibility 
 

Typically, the geometry of an element created by a Family will change depending on the current project 

view.  The visibility settings of the Family determine in which project views elements created with the 

Family will display. 

 

For instances, a flashing light has a symbolic 2D Annotation shown on Plan View for preparing 

construction drawing and it contains a 3D geometry shown on 3D View for rendering 

    
Visibility on Plan View   Visibility on 3D View 

 

 

In a plan view, you may want to see a 2D representation of the element.  In a 3D or elevation view, you 

may want to display a fully detailed 3D representation of the element.  In other views, you may want to 

hide the element.  Limiting the visibility of highly detailed Family geometry to only certain views can 

improve project performance. 
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4 Consideration for Nesting Family Content 
 

A nested Family is one that has been loaded into another Family.  In some cases, it can be convenient 

to represent parts of the nested Family separately from the main Family model.  For example, you 

could create a windowsill Family and nest it in a window Family.  This allows you to build upon previous 

work while creating Families suited to your needs. 

 

Nesting Recommendations: 

 Instead of nesting, consider creating all of the necessary geometry in the Family.  Use reference 

lines and labels to lock geometry in place. 

 

 Limit nesting to 2 levels ‐ The deeper that Families are nested, the longer they take to update in 

the project file. 

 

 Only nest high‐value content that may be used in several different Families, such as a door 

handle. 

 

IMPORTANT:  It is important to understand that nesting Families increases the file size and affects 

performance, specifically the regeneration process of the Family views. 
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5 Planning a Revit Model Family 
 

Planning Families prior to creation can save time and prevent errors.  The following questions should 

be considered while planning the Family. 

 

 Will the Family need to accommodate multiple sizes? 

For a window that is available in several preset sizes, or a bookshelf that can be built in any length, 

create a standard component Family. 

 

 How should the Family display in different views? 

The way the object should display in views determines the 3D and 2D geometry that you need to 

create, as well as how to define the visibility settings.  Determine whether the object should display 

in a plan view, elevation view, and/or sectional views. 

 

 Does this Family require a host? 

For objects typically hosted by other components, such as a window or light fixture, start with a 

host‐based template.  How the Family is hosted (or what it does or does not attach to) determines 

which template file should be used to create the Family. 

 

 How much detail should be modeled? 

In some cases, you may not need 3D geometry. You may only need to sketch a 2D shape to 

represent your Family.  Also, you may simplify the 3D geometry of your model to save time in 

creating the Family.  For example, less detail is required for a wall outlet that will only be seen in 

interior elevations from a distance, than for a door with raised panels and a sidelight that will be 

seen in an interior rendering. 

 

 What is the insertion/origin point of this Family? 

The insertion/origin point is the point at which you want to place the Family in a project (indicated by 

the cursor position).  The insertion point may change based on use case. For example, the 

insertion point for windows and doors is the center of the geometry, so that the content 

parametrically expands from the center out.  For a countertop, the insertion point is at a corner and 

the content expands with the instance length in one direction.  Determining the appropriate 

insertion point will help users place the Family in a project. 
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6 Workflow for Model Content Creation 
 

To ensure that your content is created in the most efficient and least error‐prone manner, review and 

use the best practice workflow below before you create a model Family. 

 

1. Create a new Family file (.rfa) with the appropriate Family template. 

 

2. Define subcategories for the Family to help control the visibility of the Family geometry. 

 

3. Create the Family skeleton, or framework: 

 Define the origin (the insertion point) of the Family. 

 Lay out reference planes to snap to when you sketch component geometry. 

 Add dimensions to specify parametric relationships. 

 Label dimensions to create type or instance parameters or 2D representation. 

 Test, or flex, the skeleton. 

 

4. Define Family type variations by specifying different parameters. 

5. Add a single level of geometry in solids and voids, and constrain the geometry to reference 

planes. 

6. Flex the new model (types and hosts) to verify correct component behavior. 

7. Repeat previous steps until the Family geometry is complete. 

8. Specify 2D and 3D geometry display characteristics with subcategory and entity visibility settings. 

9. Save the Family, and then test it. 

10. For large Families that include many types, create a type catalog. 

 

TIP:   For more information on the steps in this workflow, download the Revit® Architecture 2009 

Families Guide (www.autodesk.com/revitarchitecture‐documentation), and see the Creating Standard 

Component Families topic. 
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7 Family Units 
 

Although Families can be created as unit‐specific (imperial or metric), Revit software stores all 

coordinates in universal units and displays specific units according to user preference. This means that: 

 Units can be set to display as necessary for a target audience (i.e., display as decimal units for a 

civil engineering drawing or fractional units for an architectural drawing). 

 Families created in imperial units may be loaded into and used in metric projects and vice versa. 

For information on changing the display of units, see “Project Units” in the Revit Help. 

 

To use an imperial or metric family in a project with different base units, use one of the following options: 

 Load the family in the project where it will use the current project units. However, any imperial‐ or 

metric‐specific text in the family name, type names, and parameter names will still display as 

metric unless explicitly changed. Standards sizes may also need to be adjusted. 

 Duplicate the types within a metric or imperial family to create both imperial and metric types 

within the family. 

 Open the family, save it as a new family, and change the units. 

 

Note:  The units of all Family found in FLIP are metric according to local practices. 
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8 Family Naming Conventions 
 

Family naming conventions ensure that Families can be identified in FLIP and the Revit software by the 

real‐world items that they create. The naming conventions include short forms of category, functional 

type, originator and descriptors that allow the user to search for Families by element, by manufacturer, 

and/or base units. 

 

Guidelines: 

 Create a unique name for each Family. For example, a fixed window Family and a fixed door 

Family cannot share the same name. 

 Use ‘title casing’ (as with the title of a book) for Family names, as they are case sensitive. 

 Keep file names as short as possible. Family names must display in dialogues and in the Type 

Selector. 

 When adding optional descriptors to Family file names, consider the order in which the descriptors 

are listed to ensure that the Family files display in the Project Browser in the most logical and 

intuitive order. 

 Do not use spaces between words in file names. To separate words within a syntax element (e.g., 

Manufacturer or Descriptor), use the underscore character (_). 

 If a hyphen (‐) is used to include a performance range, enclose the range in parentheses, for 

example, (230‐250_Ton). 

 If a type catalog is to be used with a Family, name the type catalog (.txt file) with the same name 

as the Family. 
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Format 

<Category> - < Functional Type > - <Originator> - <Descriptor 1> - <Descriptor 2> 

 

Family Name DOR – SGL – AEC – Wood – w_Louver .rfa Descriptions 

Category* DOR – SGL – AEC – Wood – w_Louver .rfa A Door, DOR is the short form of the category 

“door”  

Functional Type * DOR – SGL – AEC – Wood – w_Louver .rfa A Single Door, SGL is the short form of the 

functional type “single” 

Originator DOR – SGL – AEC – Wood – w_Louver .rfa AEC is the short form of the default Architecture -

Engineering -Construction Industry. It can be 

replaced by the name of the creator in short form of 

three characters. (e.g. ASD, BD, CLP, DSD, EMD) 

Descriptor 1 DOR – SGL – AEC – Wood – w_Louver .rfa A door is made of Wood. An optional descriptive 

text. 

Descriptor 2 DOR – SGL – AEC – Wood – w_Louver .rfa A door is built with Louver This text further 

describes the Family 

File Extension DOR – SGL – AEC – Wood – w_Louver .rfa Revit Family File Extension 

 

* Note:  Refer to the FLIP Master Type List for information on approved Category and Function Type. 

In the library webpage of FLIP, a user can look for a Family by searching the keyword appears on any 

field of the Family file name or by filtering the Category and Function Type of the Family. 
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9 Type Naming Conventions 
 

All Families must include one predefined type. Unless they represent nominal sizes, type names should 

include units or capacity, and include a unit indicator. 

When naming a Family type, use the format and rules below: 

 

Guidelines 

 Do not include the Family name or category in the type name. 

 Type names should mirror actual usage. 

 Type names should indicate the key differences between types (size, count, material) and, when 

applicable, reflect standard sizes. In some cases, you may base names on size difference, but 

use common terms rather than numbers. 

 When types are named by size, use dimensions only. Avoid the use of characters or words. (h, w, 

d, or height, width, depth). 

 Type names should include units or capacity and a unit indicator, unless they represent nominal 

sizes. 

 Metric types should reflect the local unit standard, unless the types are intended to be generic. 

 Keep type names as short as possible. Type names must display in dialogs and in the Type 

Selector. 
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Format 

Unless there is a market‐specific reason to do otherwise, use the following general order in type names: 

For doors and windows:  <width> x <height> 

For casework and furniture:  <width> x <depth> x <height> 

 

Below is an example of a Window Family with different Family Types 

 

 

For families that feature nominal sizes or industry‐standard terms: 

 

In type names, drop the dimension indicators (mm) and/or use industry‐standard naming conventions. 

 Brick (industry‐standard naming):   Common, Norman, CSR, Metric Modular 

 Lumber (nominal sizes):    2x4 

 Structure (industry‐standard naming):  W12 x 204 
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10 Category and Sub-category Standards and Usage 
 

All families, including generic families, must be assigned to appropriate categories and subcategories. 

When a family is created, it is assigned a category. The category defines its top level of identification (for 

example, Door, Window, or Casework) within the project environment. When the family is used in a 

project, the family can be located in the Project Browser under its category, and elements created by the 

family types will schedule by its category. The line weight, line color, line pattern, and material 

assignment of the family geometry can also be assigned to by category. 

 

To display different line weights, line colors, line patterns, and material assignments for different 

geometric components of the family (for example, the frame, sash, mullions, and glass that comprise a 

window), the components can be assigned to subcategories within the family category. 

 

Categories are predefined in Revit software and cannot be created or changed by the user. 

Subcategories are predefined in some families (See Revit Master Subcategory List) , but other 

subcategories can be created in families as needed. 

 

Sub-category Naming Conventions 
 Create unique names for each subcategory. 

 Use natural language to name the subcategory. The subcategory name should describe how the 

subcategory is identified in the real world (i.e., in catalogs, by manufacturer, etc.) 

 Do not include the family category in the subcategory. 

 Keep subcategory names as short as possible. 

 Capitalize the leading letters of the words that form the subcategory name. 
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11 Approved Parameter Usage 
 

Families contain parameters that not only create the family geometry, but identify or classify the 

elements that are created by the family. All families have predefined parameters that you assign values 

or data to, but you can add parameters that are not predefined in Revit software (that are not system 

parameters). 

 

IMPORTANT:  If you want to display the names and values of custom parameters in a schedule, they 

must be defined as shared parameters in a text file that is independent of family and project files. 

 

REQUIREMENT:  To promote consistency in model content (particularly for manufacturer content 

that is shared on FLIP), use parameters as they are explicitly defined in the approved shared 

parameters file. If a required parameter is not in the file, add it to your content as necessary. It is also 

recommended to include the shared parameter file containing the additional parameters with your 

content package. When creating custom parameters, refer to the next chapter 12 Parameter Naming 

Conventions. 

 

Refer to the master shared parameters file (Revit Master Shared Parameters) for the list of Autodesk‐

approved shared parameters. This file contains most of the shared parameters that you will need to add 

to your families. A spreadsheet (Revit Master Parameter List.xls) that lists these parameters by family 

category, along with applicable predefined system parameters is also available for your reference. 
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12 Adding Manufacturer Data to Families 
 

Identity Data parameters in families can include manufacturer data, including information such as the 

model, description, assembly code, cost, and manufacturer URL. When elements are created with the 

family in a project, the parameters and associated values can be included in schedules. 

 

Typical manufacturer data in Family 

Parameter Name Description Type of Parameter 

Manufacturer Manufacturer name System 

Model Model name or number System 

Product Page URL URL to product page Shared (see shared parameter list) 

Product Documentation Link URL to product Shared (see shared parameter list) 

URL URL to manufacturers web site System 

 

Identity data parameters for an Escalator that include values for manufacturer data. 
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13 Parameter Naming Conventions 
 

Consistent parameter naming enables easier and more comprehensive parametric searching in FLIP. 

Create parameters only when variation creates meaningfully differentiated types that represent real‐

world possibilities. 

 

Guidelines 

 Use standard approved parameter names when available. (see Revit Master Shared Parameters)  

 Keep parameter names as short as possible. 

 Avoid abbreviation and truncation, when possible. 

 Use ‘title casing’ (as with the title of a book) for parameter names, as they are case sensitive (e.g., 

Coefficient of Performance; Point of Shipment; High and Low Pressure Gas Connection 

Diameter). 

 Parameters must display in dialogs. 

 Do not change label names provided by the Revit family templates. 

 Parameter names that you reuse to create equalities should be carefully checked for name 

coherence. 

 Use the most common descriptor for a group of parameters as the first part of the name so that 

the parameters sort logically (e.g., Filter Face Area; Filter Efficiency). 

 Parameters for subsequent items should include a number in the name before the final part of the 

description, but do not include a number in the name for the first item (e.g., Actual Hot Gas Flow; 

Actual Hot Gas 2 Flow). 

 Avoid using symbols in parameter names, including: + ‐ / \ * ( ) “ ‘ < > | ^ $ { } [ ]. 

 Do not include units in the name of a parameter (e.g., Supply Air Flow CFM). 

 Using the terms Actual or Design: 

 Actual – describes the actual value the system definition requires. “Actual” parameters are 

linked to connectors and are often used for parameters that define flow rates, for example, Actual 

Supply Air Flow; Actual Chilled Water Flow. 

 Design – describes what the product is designed to do, for example, Design Ventilation Air 

Flow; Design Return Air Flow. 

 Name Yes/No parameters so they imply that they return a Yes/No value, for example: 

 Has Handle 

 Is Energy Efficient 

 Show Hoods 
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A. Parameters that apply to the entire Family 
Format: 

<Type of measurement/ Descriptor> 

 

Examples: 

Casement Window: 

 Height 

 Default Sill Height 

 Width 

Engineering Equipment: 

 Actual Heater Gas Flow 

 Full Load Current 

 Compressor Type 

 

B. Parameters that describe a measurement value of a sub-component 
Format: 

<Function/Object> <Type of measurement/ Descriptor> 

 

Examples: 

   Heat Pump Coil Face Area 

   Exhaust Fan Blade Speed 

   Exhaust Fan Drive 

 

C. Parameters that describe the Linear Dimension of a sub-component (Connector) 
Format: 

<Function/Object> Connection <Type of measurement/ Descriptor> 

 

Examples: 

   Hot Gas Bypass Connection Diameter 

   Condenser Water Connection Diameter 

   Supply Air Connection Width 
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14 Material Naming Conventions 
 

Finish material naming conventions organize the material by manufacturer, and general description to 

more specific description. Depending on the type of material, a finish material name may include a color, 

code, finish type, or identification number. 

 

Guidelines 

 Finish names should indicate the key differences between materials (manufacturer, type, color, 

finish) and, when applicable, reflect standard sizes. In some cases, you may base names on size 

difference, but use common terms rather than numbers. 

 Metric finish names should reflect the local unit standard, unless the materials are intended to be 

generic. 

 Keep finish names as short as possible. 

 

RECOMMENDATION: To optimize the file size for families with a large number of available materials, 

provide only the most common materials in the family, and provide the remaining materials in a separate 

finish library. See the Finishes part type guide for more information. 

 

A. Individual Finish Materials (Stored Inside Projects) 
Format: 

<Finish Type> ‐ <Manufacturer> ‐ <Code> ‐ <Descriptor> 

 

Examples: 

 Paint – AEC Paint – AC440 – Vintage Brown Matte 

 Glass – AEC Glazing – Series 1205 – Clear 

 Aluminum – AEC Metal – AC120 – Anodized (Clear) 

 Fabric – AEC Fabrics – AC F820 – Hounds tooth – Black/White 
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B. Individual Finish Materials Using an External Image File 
Materials requiring external images, bump maps and cutout should be stored in a location that can be 

shared by multiple Revit Product installs. 

 

For Windows XP: 

C:\Documents and Settings\All Users\Application Data\Revit Manufacturer Library\Materials\<MFG> 

For Windows Vista and Windows 7: 

C:\ProgramData\All Users\Application Data\Revit Manufacturer Library\Materials\<MFG> 

 

Guidelines: 

 Create unique names for each unique material image. 

 Capitalize the leading letters in each portion of the family name. 

 Do not use spaces between words in file names. Use the underscore character (_). 

 Acceptable file formats for material images include: bmp, jpg, jpeg and png. 

 Provide a readme to describe where the image files must be located and how to map Revit to the 

“Revit Manufacturer Library” folder in the Rendering Options dialog. 

 

C. Individual Finish Materials Images 
 

Format: 

Material Image: 

<Finish Type>‐<Manufacturer>‐<Code>‐<Descriptor> + file extension 

 

Bump maps: 

<Finish Type>‐<Manufacturer>‐<Code>‐<Descriptor>‐bump + file extension 

 

Cutouts: 

<Finish Type>‐<Manufacturer>‐<Code>‐<Descriptor>‐cutout + file extension 

 

Examples: 

 Satin–AEC_Windows–Natural_Wood_Finish.jpg  

 Satin–AEC_Windows–Natural_Wood_Finish–bump.jpg 

 Aluminum–AEC_Fencing–AC120–Anodized–cutout.jpg 
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15 Preview Image Standards 
 

A Family preview image is a reduced thumbnail image of a 2D or 3D Family view that graphically 

identifies a Family before it is downloaded or opened. Preview images display in: 

 Thumbnails view in Microsoft® Windows Explorer 

 FLIP search results 

 The Preview window in Revit Open and Load Family dialogs when a Family is selected 

By creating preview images that adhere to Autodesk standards, users can view consistent previews 

across Families, ensuring a consistent user experience both in FLIP and in Revit software. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Back to Contents Page  



 

24 

Creating FLIP Standard Family Preview Images 

 

To create a preview image, begin by creating a family view to use exclusively for the preview image. 

Although you can save any family view as the preview image view, the best practice is to create a view 

that can be set to consistently display as is required for the preview image. 

 

After you create the view, set FLIP standard graphic controls in the preview image view to ensure visual 

consistency with the preview images of other Revit families. Different graphic standards exist for the 

following types of family preview images: 

 Detail component and annotation families 

 Hosted model component families 

 Non‐hosted model component families 

 

NOTE:  Although annotation families are not covered in this guide, similar standards for annotation 

preview images exist. 

 

IMPORTANT:  When modifications to the preview image view are complete, save the view and set 

the family to use the current view as the preview image. Each time you save and close the family, you 

must ensure that the preview image view is the active (open) view so it will display as the preview 

image. 

 

 

A To Create a Detail Component Preview Image: 
Create a view to use as the family preview image 

1. If necessary, open the detail component family for which you want to create a preview image. 

 

Turn off visibility of dimensions and reference planes/lines 

2. Click View menu →Visibility/Graphics. 

3. In the Visibility/Graphic Overrides dialog, click the Annotation Categories tab. 

4. Under Visibility, clear Dimensions, Levels, Reference Lines, and Reference Planes. 

5. Click OK. 

 

Set standard view controls in the Preview view 

6. On the View Control Bar: 

 Click the current view scale, and depending on the family units, click 1:5. 

 Click Detail Level, and click Fine. 

 Click Model Graphics Style, and click Wireframe. 

7. Click Save.  
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B To Create a Model Component Preview Image: 
Create a view to use as the preview image 

1. If necessary, open the family for which you want to create a preview image. 

2. In the Project Browser, select a view of the family that you want to use: 

 For a door or window family, select an elevation view (preferably front). 

 For other model component families, select a 3D view. 

3. Right‐click the view name, and click Duplicate View→ Duplicate. 

4. Rename the duplicate view: 

 In the Project Browser, right‐click the view name, and click Rename. 

 Type Preview and click OK. 

 Click No to retain the names of corresponding views and levels. 

5. If necessary, open the view. 

 

Set a standard preview image view orientation 

6. Depending on the type of component that you are creating, set the view orientation: 

 For a door or window family in an elevation view, on the View Cube, click  

 For other families that display in a 3D view, on the View Cube, click  

to set a southeast orientation, right‐click, and click Set Current View as Home. 

 

Turn off visibility of dimensions and reference planes/lines and if necessary, set the host visibility 

7. Click View menu→ Visibility/Graphics. 

8. In the Visibility/Graphic Overrides dialog, click the Annotation Categories tab. 

9. Under Visibility, clear Dimensions, Levels, Reference Lines, and Reference Planes. 

10. If you are creating a preview for a host‐based family, set the host visibility: 

 For family previews in which the host should not display, such as doors and windows, clear 

all host categories. 

 For family previews in which the host should display, select all host categories. 

11 Click OK. 

 

Set standard view controls in the Preview view 

12 On the View Control Bar: 

 Click the current view scale, and depending on the family units, click 1 1/2” = 1’ ‐ 0” or 1:5. 

 Click Detail Level, and click Fine. 

 Click Model Graphics Style, and click Shading with Edges. 
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Set the preview image to display the current view 

13 Click File menu → Save As. 

14 In the Save As dialog, in the lower‐right corner, click Options. 

15 In the File Save Options dialog, under Preview, for Source, select “3D View: Preview”, then select 

“Regenerate if view/sheet is not up‐to‐date”. 

 
 

IMPORTANT:  This setting displays the selected view as the preview image. It is also recommended 

that the active view when you save the file is the same as the selected preview view. 

 

TIP:  Select the Compact File option to help reduce the file size. 

 

16 Click OK. 

17 Click Save. 
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16 Type Catalog Standards and Usage 
A type catalog is comma‐delimited TXT file that, when placed in the same directory as a family, displays 

a list of family types before the family is loaded into a project. You can select and load only the family 

types that the current project requires, avoiding an unnecessary increase in project size from unused 

types and a long list of types in the Type Selector. The type catalog also provides an external means of 

editing the family, as you can remove and add parameters and types in the catalog file (TXT). 

 

Type Catalog Standards 

Use the following standards when creating type catalogs: 

 Use any text editor to create type catalogs. 

 Create type catalogs for families that contain six or more types. 

 Name a type catalog file (.txt) with the same name as the family file (.rfa) that it supports. 

 Ensure that parameters in type catalogs are test loaded by the family for which you create the 

type catalog. If the parameters are not used, the family will not load. 

For more information about creating a type catalog, please refer to the Revit Help below: 

http://help.autodesk.com/view/RVT/2014/ENU/?guid=GUID-FFA71D72-D4C5-416D-BF65-

1757657C3CE9 

 

Example 

A type catalog (TXT file) for a table Family 

 

Dialog displayed by the type catalog when the door family is loaded 
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17 Best Practices for Adding Connectors in Revit MEP 

Families 
 

In Revit MEP, the connector connects the single family component with other components to create 

MEP systems. Without a connector, an RME family would just be a static placeholder. 

In Revit MEP, there are 3 kinds of connectors: 

 Electrical Connector 

 Duct Connector 

 Pipe Connector 

 

Adding a connector 
 

1. Click the tool for the connector you wish to add (Electrical Connector, Duct Connector, or Pipe 

Connector). 

2. Click to place the connector in the drawing area. 

RME provides two ways to place the connector, placing it on a face or on a work plane. If you 

select the Place on Face option, the connector is automatically added to the center of the face of 

the geometry and moves with the face. If the geometry is deleted, the connector is also deleted. 

 

BEST PRACTICE:  Place connectors on a face rather than on a work plane. 
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System Types 
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Connector Direction 
 

For duct/pipe connectors, an arrow, perpendicular to the surface, displays. The direction that the arrow 

is pointing is also the direction in which the connecting duct/pipe will be drawn. As the picture shows, 

vertical duct can be drawn from an up connector in an air terminal. 

NOTE:  The arrow does not represent the flow direction. 

 
 

 

Primary Connector 
 

By default, the first connector in each domain is assigned as the primary connector. In the following 

image, you can easily identify the primary connector (connector 1) by the cross symbol. The Re‐assign 

Primary tool allows you to reassign the primary connector, as required. 

 

The primary connector of pipe and duct fittings should be located at coordinates (‐1, 0, 0). In the 

following image of the plan view of a P‐Trap, connector 1 is the primary connector. 

 

For other families, the location of the primary connector is not important. 
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Linking Connector 
 

When there are more than one pipe/duct connectors, there is a choice for linking connectors. 

 
 Linked connectors only have an effect when the system type is set to global for equipment or 

fitting. 

 Linking connectors on equipment makes it possible to propagate engineering data, allowing you to 

use equipment as an inline component in a system. 

 Linking connectors on fittings should include the primary connector. 

 

Connector Mapping 
 

Edit Element Properties for the connector to define parameters for the connector. 

 
For part parameters, clicking a browse button displays a dialog that makes it easy to map connector 

parameters to family parameters with the same units. Connector mapping makes the connector 

parametric with the family. 



 

32 

Connector Descriptions 
 

In the following example of complex equipment, it would be difficult to determine the function of each 

connector. 

 

To make it easier to identify the function of connectors in the family, add connector descriptions. These 

descriptions display in the Select Connector dialog. In the following image, descriptions are underlined 

in red for illustration purposes. 
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18 Exchange the Family files in FLIP 
 

FLIP is an interactive platform that facilitates and encourages Revit users to share and exchange 

organized families to enhance productivity as a whole. To gain access to FLIP, refer to the webpage of 

Autodesk Industry Advisory Board (AIAB): http://aiab.org/index.php/background  

 

 
 

 

There are four sections in the FLIP webpage 

 

A Background 
Users can find the background information and the purpose of developing the FLIP project. 
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B Library 
This is the place where users can download the family library in FRA format according to FLIP standard. 

Before downloading or uploading a family, a user has to be a registered member of AIAB. 

 

 The Credit Pont Mechanism  

By default, each AIAB member has been allocated with 10 credit points. 1 credit point will be deduced 

for each download of a family package which may include a Revit Family File and Supporting Files 

(such as reference drawings, type catalogues, shared-parameter files and material files etc.). The user 

will gain 10 credit points by uploading a family package.  

Note:  In order to encourage users using the FLIP system, downloading families will not deduct 

credit points during the promotion period.  

 

 Downloading a Family 

A user can download a family either by searching the keywords of the name or descriptions of the 

family or by filtering with category.  Family name, descriptions, a thumbnail, published date, 

author name Category and Revit Version will be shown in the searching or filtering results. 

 

 

 

 Making Comments 

In order to encourage users share their ideas and to make a better family in the FLIP system, 

other users can add comments to the Family listed on FLIP. The user name for the commenter 

and the author will be shown. 
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 Uploading a Family 

Only registered AIAB member can upload files to the FLIP system 

 
 

 

A user can upload a family package to the FLIP system by filling a form providing the following 

information: 

 

 Family Name 

This is a name for other user to search for the family package, not the family name itself. 

 

 Category 

User should specify the category of the family according to FLIP Master Type List. 

 

 Functional Type 

User should specify the Type of the family according to FLIP Master Type List. 

 

 Family File 

A pop-up window will be launched as the user click the box. User can upload the Family file to be 

shared. Only RFA file is accepted. 

 

 Thumbnail 

A pop-up window will be launched as the user click the box. User can upload the Thumbnail image 

to be displayed in the FLIP system. Only JPG, GIF, PNG and BMP files are accepted. 

 

 Revit Version 

Revit is not upward compatible. (i.e. Revit 2013 cannot open files created by Revit 2014 or later.) 

Indicating the Revit version of the family created is essential. 
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 Description (Optional) 

This is a description for other user to search for the family package.  

e.g.  Parametric concrete pile cap with 2 parametric steel piles. Manufactured by ABC Company 

with Model No. PC202. 

 

 Other supporting files (Optional) 

User can provide other supporting file such as reference drawings (DWG files), type catalogues 

(TXT files), shared-parameter files (TXT files) and material files and texture files (JPG, GIF, PNG 

and BMP files) etc. 

 

 
 

Click Submit to confirm upload 

 

Note:  Users can no longer make any changes once the family has been submitted. They are 

advised to check carefully of what to be uploaded. 
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C FLIP Guidelines 
 

Users can download the latest technical documents of how to make use of the FLIP system 

 

 The FLIP Guideline 

A guideline description the framework of the FLIP system 

 

 FLIP Master Type List 

Suggested Family Type for use with the FLIP system based on FLIP-specific naming convention 

system and technical consideration for the local market 

 

 Finishes Part Type Guide 

Suggested Finishes Part Type for use with the FLIP system based on FLIP-specific naming 

convention system and technical consideration for the local market 

 

 Revit Master Parameters List 

Parameters suggested by Autodesk for use with Revit with modification for local use. 

 

 Revit Master Shared Parameters 

Shared parameters suggested by Autodesk for use with Revit with modification for local use. 
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D FLIP Training 
 

Users can find the latest information about the FLIP demonstration of incorporating FLI P into Revit 

Projects and procedures of making Families for FLIP. 
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- End of Guidelines – 
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